
Advanced lab course for

bachelor students in physics

RWTH Aachen

Experiment T3

γγ-Angular Correlation

February 2023



Contents

1 Introduction 4

2 Theory 4

2.1 γ-Energy Spectroscopy with Scintillation Detectors . . . . . . . . . . . . . . . 4

2.2 Angular Distribution of γγ Events . . . . . . . . . . . . . . . . . . . . . . . . 7

2.3 True and Random Coincidences . . . . . . . . . . . . . . . . . . . . . . . . . . 8

2.4 Radioactive Sample: 22Na . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

2.5 Radioactive Sample: 60Co . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

3 Employed Hardware 12

3.1 Fast and Slow Coincidence Circuit . . . . . . . . . . . . . . . . . . . . . . . . 12

3.2 NIM Standard and Delaying Signals . . . . . . . . . . . . . . . . . . . . . . . 13

3.3 Main Ampli�er . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

3.4 Single-Channel Analyser (SCA) . . . . . . . . . . . . . . . . . . . . . . . . . . 14

3.5 Multichannel Analyser (MCA) . . . . . . . . . . . . . . . . . . . . . . . . . . 14

3.6 Coincidence Unit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

3.7 Counter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

4 Procedure 16

4.1 Energy Spectroscopy . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

4.2 Coincidence Measurement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

4.2.1 22Na Annihilation Peak . . . . . . . . . . . . . . . . . . . . . . . . . . 18

4.2.2 Finding the Annihilation Peak . . . . . . . . . . . . . . . . . . . . . . 21

4.2.3 Angular Distribution of 60Co . . . . . . . . . . . . . . . . . . . . . . . 21

5 Analysis 23

5.1 Energy Spectroscopy . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

5.2 Coincidence Measurement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

5.2.1 22Na Annihilation Peak . . . . . . . . . . . . . . . . . . . . . . . . . . 24

5.2.2 Angular Distribution of 60Co . . . . . . . . . . . . . . . . . . . . . . . 24

A Räumliche Gestalt der γ−Strahlung 26

B Die Parität 29

2



C Koinzidenzmessung 30

D Introduction of the PicoScope 33

D.1 Setup of the PicoScope . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

D.1.1 Hardware . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

D.1.2 Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

D.2 Using the software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34

D.2.1 General remarks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34

D.2.2 Scope Mode and Persistence Mode . . . . . . . . . . . . . . . . . . . . 34

D.2.3 Changing the display of the input signal . . . . . . . . . . . . . . . . . 36

D.2.4 Trigger . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

D.2.5 Saving waveforms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

D.2.6 Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

D.2.7 Math Channel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40

3



1 Introduction

Nuclear spectroscopy is one of the most important �elds of nuclear physics. γ quanta are
emitted in transitions between excitation states of a nucleus. By measuring the angular
distributions of these emissions, conclusions can be reached on nuclear properties like nuclear
spin and parity.

Often, excited nuclei transition to the ground state via a decay cascade. In many cases, the
lifetime of an intermediate state is so short, that the nucleus cannot change its orientation
within this time. In this case, the �rst quantum can be used to �x the radiation axis. The
direction of the second quantum is then measured relative to this. For γγ-angular correlation,
such correlated γ quanta or �coincidences� are detected. The angular distribution of the
coincidence rate provides a window into the radiation characteristics of the nucleus.

2 Theory

2.1 γ-Energy Spectroscopy with Scintillation Detectors

To detect the γ radiation, scintillation detectors with connected photomultipliers are used.
The detection of the γ radiation happens indirectly via the interaction of the photons with
the scintillator material. There are three signi�cant e�ects that determine the characteristics
of the energy spectrum of a sample and cause either complete or partial energy transfer of
the photon to electrons.

� The photoelectric e�ect occurs when the photon interacts with an absorber atom. The
photon is absorbed and passes its energy h · ν on to a previously bound electron, which
is now free. The free electron has an energy equal to the energy of the photon minus its
binding energy Eelectron = h·ν−Ebinding. The majority of the photon's energy therefore
remains as the kinetic energy of the electron. The unoccupied spot, which is left behind
by the freed electron, is usually �lled quickly by an electron from the outer shells of the
atom, the higher-energy electrons again releasing their energy through photons, which
are absorbed in the outer shells and are therefore rarely detected. The photoelectric
e�ect is especially dominant for absorber materials with high nuclear charge numbers
Z. For the cross section σ, we can write σ ∝ Z5

Eγ
3 .[1]

� The Compton e�ect involves an interaction of the photon with an electron from the
absorber material. The photon changes direction and transfers part of its energy to the
electron. The energy transfer depends on the impact angle between the photon and the
electron and ranges from zero to almost h · ν. The remaining photon energy is

h · ν′ = h · ν
1 + (1− cos(θ)) · h·ν

me·c2
,

so the distance of the Compton edge (θ = 180°) from the photopeak in the energy
spectrum is

EC =
h · ν

1 + 2 · h·ν
me·c2

.
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Assuming h ·ν ≪ 1
2 ·me ·c2, it follows that EC ≊ 1

2 ·me ·c2. Up until the Compton edge,
there is a continuous spectrum, which corresponds to Compton scattering for angles
from 0° to 180°. The energy spectrum also contains energies between the Compton edge
and the photopeak. These can be explained by multiple Compton scattering. The cross
section of Compton scattering is given by the Klein-Nishina formula. The backscattering
peak is also due to Compton scattering. It is caused by photons that interact with the
materials surrounding the detector and scatter by more than 120°. The backscattering
peak is located around Ebackscattering = EC ≈ 1

2mec
2.[1]

� The third interaction is pair creation. If the photon energy Eγ = h · ν is larger than
twice the rest energy of an electron mec

2, then pair creation is possible, producing an
electron and a positron from the photon. Additional photon energy becomes kinetic
energy of the created electron-positron pair, which both lose it again via interactions.
The kinetic energies satisfy Ekin

electron + Ekin
positron = h · ν − 2 · me · c2. The produced

electron stays in the absorber material, the positron annihilates with another electron
in its vicinity. This produces two photons of energy 511 keV. If both of the annihilation
photons and the photons due to the deposition of kinetic energy are registered, this
once again adds up to the energy of the photon and so this case is registered in the
spectrum as part of the photopeak. If one of the annihilation photons escapes from the
material without being detected, this creates a single-escape peak at Esingle−escape =
hν −mec

2. If both annihilation photons escape, the resulting double-escape peak lies
at Edouble−escape = hν − 2mec

2.

In addition to these three e�ects, there are many other e�ects and superpositions of e�ects,
which lead to a continuous spectrum. For certain spectra, this leads to an observable and
measurable linear background, which is why in the analysis of the spectra the peaks are
determined using a superposition of Gaussian curves and a �rst-degree polynomial.

All three interactions described also cause the attenuation of γ radiation in matter. The linear
attenuation coe�cient µ can be calculated using the sum of the interaction cross sections.
The intensity of the photons decreases exponentially and is described by I = I0 · e−µx after
penetrating the absorber material by the distance x.

The scintillator material should ful�l certain requirements. First, the material used should be
sensitive to the type of radiation and the relevant energy range. Secondly, it should result in
a relation between photon energy and scintillation photons that is as linear as possible, which
later results in a linear relation between photon energy and pulse height of the voltage pulse.
The scintillator material should also be transparent to the produced scintillation photons. It
should be malleable and have a refractive index of ca. 1,5, to ensure an e�cient transition
to the photocathode of the photomultiplier. The scintillators employed here use thallium-
doped sodium iodide (NaI(Tl)). This is an inorganic scintillator material. Inorganic materials
are slower than organic materials, but o�er a large and linear light yield. NaI(Tl) is linear
on almost the entire energy range and because of this a standard material for scintillation
detectors today. The disadvantages of NaI(Tl) are its mechanical strength (fragile) and the
fact that it is hygroscopic and as such must be protected from moisture in the air.

The processes inside the scintillator material can be explained using the energy band model.
In inorganic materials, the conduction band contains free electrons, whereas the valence band
contains bound electrons. In a pure material, there are no allowed states within the band
gap between both bands. By doping with an activator, however, the new excited states and
ground states of the activator are added. If a charged particle moves through the material,
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electron-hole pairs are created. The created holes move towards activator atoms and ionise
these, exciting them to higher energy levels. The electrons, on the other hand, are put into
the conduction band and move freely through the crystal, until they reach ionised, excited
activator atoms. The neutralised activator atom quickly returns to the ground state, emitting
a scintillation photon in the wavelength range of visible light.

Figure 1: Band model of a scintillator material with valence and conduction bands of the
base material and additional levels of the introduced activator material.

Because the scintillator is transparent to light in the visible spectrum, the created scintillation
photons reach the photocathode of the photomultiplier (PM). Here, they create one electron
in the PM through the external photoelectric e�ect. These electrons are bundled and then
accelerated by an applied voltage onto multiple, successive dynodes. The electrons are always
accelerated so strongly, that they create secondary electrons at each dynode. For average
dynode materials, roughly 5 to 10 electrons are produced per dynode and incident electron.
The ampli�cation can be described by V = δN , where N is the number of dynodes, the
PM used in this experiment has 10, and δ is the number of freed secondary electrons. The
creation of secondary electrons is a statistical process, so the uncertainty is

√
δ. In this way,

several hundred incident photons can be converted into a measurable voltage pulse. Typically,
105−107 electrons reach the anode for each electron freed from the photocathode, depending
on the PM.

Important quantities for the characterisation of the detectors used are the energy resolution
and the e�ciency. The energy resolution dictates, which photon energies can still be measured
separately and the e�ciency indicates, how many of the arriving photons are converted into
a measured signal. The energy resolution is energy-dependent. The relation can be described
by

∆E

E
=

√
a2 +

b2

E
(1)

A distinction is made between two types of detector e�ciency. The total e�ciency is de�ned as
ϵtot =

registered events
events emitted by the source and the intrinsic e�ciency as ϵint =

registered events
events reaching the detector .

In our case, the intrinsic e�ciency is of interest, i.e. the amount of events reaching the
detector that are converted into an electrical signal. The following holds:

εint =
4 · π · r2 ·m
FD ·A · Iγ

The registered events are calculated from the count rate m, i.e. the sum of all registered
particles averaged over the measurement time. The events reaching the detector can be
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calculated from the the number of particles produced by the decay considered and a geometrical
factor. The number of considered particles corresponds to the product of the activity of
the sample A and the fractional contribution of the considered decay to the total activity,
described by Iγ . The geometrical factor approximately results from the fraction of the surface
area of a sphere of radius r, which is the distance between the source and the detector,
covered by the detector surface FD. This approximation assumes that the particles propagate
uniformly in all directions and that the curvature of the sphere at the detector surface can be
neglected. Additional information on energy spectroscopy and the workings of the detectors
can be found in the instructions to experiments T1 and T2.

2.2 Angular Distribution of γγ Events

Two di�erent γγ production mechanisms are investigated during this experiment. The �rst
is the production of γγ by e+e− annihilation. This produces two γ's at an angle of 180°. The
second mechanism is the creation by a decay cascade inside a nucleus. For such a decay with
a transition from Ii to If , the distribution of emitted γ's is isotropic, if

� all (2 · Ii + 1) possible substates with di�erent magnetic quantum numbers (m) are
occupied equally and

� all possible transitions from (Ii, mi) to (If , mf ) are observed.

For the simple transition from Ii = 1 to If = 0, for example, there are three possibilities with
probabilities:

W+ =
3

16
· π · (1 + cos 2θ) (2)

W 0 =
3

8
· π · sin 2θ (3)

W− =
3

16
· π · (1 + cos 2θ) (4)

Due to the limited energy resolution of the employed detectors, only the combination of these
transitions can be observed and so one gets:

W =
∑

Wi =
3

4
· π (5)

So the intensity is distributed isotropically across all angles θ. Only when the magnetic
substates are occupied unevenly, i.e. distributed anisotropically, is it possible to measure an
angular distribution.

The coincident measurement o�ers a solution to this problem. Because one can only measure
the angular distribution relative to a �xed quantisation axis, the emission of the �rst γ−
quantum �xes such an axis. The substates of the intermediate system are occupied unevenly
with respect to this direction: the result is an angular distribution of the second quantum
W (θ). If the lifetime of the intermediate state is very short, then the second γ can be
measured within a de�ned time window. Such an event is called a coincidence.

A general angular distribution or �angular correlation� W (θ) can be written as:

W (θ) = 1 +A2 · P2 (cosθ) +A4 · P4 (cosθ) + · · ·+A2kmax
· P2kmax

(cosθ) (6)
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Figure 2: Quantum numbers for a γγ cascade.

, where
kmax = min (I, L1, L2) (7)

The angular momentum quantum numbers of the �rst and second γ quantum are here called
L1 and L2. The initial, intermediate and �nal states have nuclear spin quantum numbers Ii,
I and If (see �g. 2). Pν (cosθ) denote the Legendre polynomials.

For a detailed derivation, have a look at the appendix (currently German-only). The appendix
is not part of the pre-experimental discussion.

2.3 True and Random Coincidences

A distinction is made between true coincidences, from which conclusions on physical reactions
can be drawn, and random coincidences, which are caused by background events, noise or
similar processes. If one assigns two events individual detection probabilities p1 and p2, then
the single count rates of both events are N1 = p1 · A and N2 = p2 · A, provided both events
are emitted by the same source with activity A. The true coincidence count rate, i.e. the
count rate for the simultaneous occurrence of both events, therefore is N coinc

true = p1 · p2 · A.
The measured coincidence count rate N coinc

measured, however also contains a contribution from
the count rate of random coincidences N coinc

rand . The following is true:

N coinc
measured = N coinc

true +N coinc
rand (8)

When considering the random coincidences, the resolution time is of importance, since the
count rate N coinc

rand indicates, how many events occur within the resolution time independent
of physical reactions. The resolution time of the measurement process is determined by the
pulse width, the rise time of the pulse and the response times of the devices used. If one
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assumes the idealised case where both events need the same time τ , then the resolution time
is TA = 2τ . This results in [8]

N coinc
rand = TA ·N1 ·N2 = 2τ · p1 · p2 ·A2 (9)

The resolution time should be chosen such that all true coincidences are recorded, but
simultaneously as few as possible random coincidences occur. It is thus necessary to determine
the optimal resolution time (see section 4.2).

2.4 Radioactive Sample: 22Na

First, we consider the longest-lived arti�cial isotope of sodium, 22Na, which has a half-life of
2,60 years[8]. The isotope is converted via β+ decay (by emission of a positron) to neon:

22
11Na→22

10 Ne+
0
1 e

+ + νe (10)

The emitted positrons annihilate with electrons of the sodium itself or with electrons of the
setup (see �g. 3).

Figure 3: e−e+ annihilation.

Two photons are produced in this process, which �y away from each other at an angle of 180◦

due to momentum conservation. For exactly this reason, the isotope is very useful for the
coincidence measurement. The ideal angular distribution is of the form
W (θ) = δ(θ − π), which can be compared to measurements by the coincidence setup. From
this, the operationality of the setup can be tested and at the same time, a systematic error
on the angle measurement can be estimated, e.g. a zero o�set due to shifted collimators.

The most important transitions are shown in �g. 4. The most probable transition is the
0,5459MeV β+ transition:
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Figure 4: Simpli�ed decay scheme of 22Na with transition energies and probabilities.

2.5 Radioactive Sample: 60Co

60Co is especially well-suited for γγ angular correlation, partly due to its very clear decay
scheme with a relatively unambiguous decay mode (�g. 5). The isotope is �rst converted to
nickel via a β− decay:

60
27Co→60

28 Ni+
0
1 e

− + νe, (11)

after which the nucleus is in one of two possible excited states. 99.88% of the time, the
nucleus occupies the higher excited state and can emit two γ quanta via the intermediate
state. In the rarer case, the nucleus occupies the intermediate state and emits just one γ
quantum. After the emission of the γ quanta, the nucleus is once again in the ground state.
The lifetime of the 2+− intermediate state is only 0,7 ps, so in the case of the most common
decay mode, the emission of the second γ quantum is well-measurable as a coincidence [9].
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Figure 5: Simpli�ed decay scheme of 60Co with transition energies and probabilities.

As can be seen in the decay scheme, this is a 4 (2)−2 (2)−0 cascade. Using table 4 on page 32
and equation (6), the following correlation function is expected to be found by a coincidence
measurement:

W (θ) = 1 +
1

8
· cos2 (θ) + 1

24
· cos4 (θ) (12)

Higher powers of cos (θ) do not contribute to the correlation function, due to the additional
constraint in equation (6). The following is true for this decay cascade:

kmax = min (I, L1, L2) = 2 (13)

Using table 3 on page 30, one can see that both transitions are due to electromagnetic
quadrupole radiation.
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3 Employed Hardware

3.1 Fast and Slow Coincidence Circuit

(a) (b)

(c)

Figure 6: Circuit principles of (a) fast coincidence circuit with CFD and time-sorting of
the signals (b) slow coincidence circuit with SCA and sorting of signals by pulse height (c)
combined fast-slow coincidence circuit, where the slow circuit with SCA is triggered by the
fast circuit.

A distinction is made in measurement engineering between three coincidence methods, which
satisfy di�erent requirements. The fast coincidence has a good time resolution, the slow
coincidence a good energy resolution and the fast-slow coincidence is a combination of both
methods. The �rst part of the setups of all three methods is the detector. In this case, it
detects the photons and generates a voltage pulse, which height is proportional to the energy
of the detected photons.

For the fast coincidence method, the photomultiplier signal is ampli�ed and then passed on to
a constant fraction discriminator (CFD). The CFD records exact timestamps and emits logic
pulses. The logic signals from both CFDs are then combined in a coincidence unit, which
emits a signal only if both signals arrive within the set resolution time. Depending on the
electronics used, one of the branches processes the signal faster than the other, which must
be taken into account and corrected using a delay unit. The signals from the coincidence unit
can then be registered using e.g. a counter.

For a slow coincidence, the signal is put into a single-channel analyser (SCA) after passing
through the main ampli�er. Here, the pulses are �ltered by their pulse height, which is
proportional to the received photon energy, emitting a logic pulse only when a pulse height lies
within a chosen range. The signals from the SCAs are then also combined into a coincidence
unit after passing through a delay circuit and analysed with a counter.
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The resolution time of the fast coincidence circuit is signi�cantly shorter (about 4 ns) than the
resolution time of the slow coincidence circuit (about 500 ns). This is used in the combined
fast-slow coincidence method, where the fast coincidence circuit is used to trigger the slow
one.

3.2 NIM Standard and Delaying Signals

One standard for physical dimensions and electrical units in nuclear and particle physics is
based on individual building blocks, the nuclear instrument modules (NIMs). This standard
de�nes the external dimensions of electrical modules. The basic principle is that every module
�ts in every mount. Because of this, connectors for power supplies are also standardised. The
voltage is provided via the frame, the NIM crate. All modules described here follow the NIM
standard.

To connect two modules, coaxial cables are used. These consist of a cylindrical capacitor with
a dielectric. The cables used delay the signal by around 5,14 ns/m. This property is used in
delay units, in which cables of di�erent lengths can be combined as desired using switches.
Connecting delay units in series can be done without problems, though it should be noted
that each connection between units introduces a delay corresponding to its length and that
each delay module has an intrinsic delay of 2,5 ns. In most cases, especially in a coincidence
circuit, the time di�erence between two signals is relevant. A time di�erence can be evened
out by sending the earlier signal through a longer cable or delay units.

3.3 Main Ampli�er

The same type of main ampli�er is used for both detectors. Depending on the setup, this
is either a separate module or it is combined with the SCA. This module allows for the
ampli�cation of the signal using a coarse and a �ne setting (course and �ne gain). The
separate modules also o�er the option of pulse shaping. The ampli�er settings are chosen,
such that all channels of the pulse height analyser are used by the energy range considered.
For the pulse height analysers used, this means that the voltage pulses should lie between 0V
and 10V to be recorded. The signals from the preampli�er integrated into the PM lie in the
mV range, so the proper ampli�cation factors lie around 500. Since the signal strengths of
the PMs and their respective preampli�ers are slightly di�erent, the ampli�cation factors of
the main ampli�ers also di�er between the branches. The ampli�cation factor is the product
of the �ne gain and the coarse gain. It should also be noted, that the preampli�ers output
signals with a positive polarity. The polarity should be set accordingly for the main ampli�ers.

Adjustable signal shaping serves to improve the signal-to-noise ratio. A bell curve is used
for the signal. The shaping time corresponds geometrically to the standard deviation and is
therefore a measure of the pulse width. The shaping time should be picked, such that there is
su�cient time to collect all charge from the detector, while simultaneously being short enough
to enable high count rates. The longer the shaping time, the better the signal-to-noise ratio.
However, if the shaping time is chosen too long, multiple separate events can be combined
into one at high count rates. Commonly used shaping times for modern photomultipliers
range from 0,5µs to 2µs.

The separate main ampli�ers provide two outputs, one with a unipolar and one with a bipolar
signal, whereas the integrated main ampli�ers only have a unipolar one. The advantage of
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Figure 7: Sketch of the behaviour of the single-channel analyser. The �rst (I) pulse in the
input voltage (blue line) Uin lies below the set minimum height of EL. This limit is the lower
level E adjusted on the module. The second (II) pulse lies within the set window between
EL and EU , where EU is E + ∆E as set on the module. This pulse (II) produces a square
logic pulse of �xed duration in the output signal Uout. This output pulse is created, when the
maximum of the pulse is detected. Neither of the other pulses (I + III) satisfy the criteria
(too small or too large) and therefore do not generate an output pulse.

the bipolar signal is that the position of the zero crossing is independent of the amplitude
and therefore well-suited as a time signal. However, the bipolar signal also has more noise
than the unipolar signal. For spectroscopy and the coincidence measurement, the unipolar
signal is used.

3.4 Single-Channel Analyser (SCA)

Depending on the setup, two di�erent modules are used as single-channel analysers: either a
separate module or combined with the ampli�er. Nonetheless, both function in the same way
and di�er only in some details.

The de�ning job of an SCA is to �lter signals according to their amplitude. If the amplitude of
an input pulse lies within the set limits, a digital, square output pulse is created. If the pulse
height lies outside of the set limits, no output pulse is generated. On the modules employed,
the lower limit E and the window width ∆E can be set. The upper limit is E + ∆E. The
lower limit as well as the window width can be picked from the range 0V to 10V on both
SCA modules. On the separate SCA module, the window range can additionally be switched
from 10V to 1V, allowing for a �ner adjustment of small window widths.

3.5 Multichannel Analyser (MCA)

For energy spectroscopy, it is counted how many times which energy is measured within a
prede�ned time. To this end, the ampli�ed pulse height, which is linear in the detected
scintillation light, which in turn is linear in the energy of the absorbed γ, is measured and
digitised. In digitisation, the pulse heights in the range 0− 10V are converted to an integer
number from 0 to 16383. Each of these integers corresponds to a channel with its own counter.
All channels are of equal width. During the analysis, each channel can be assigned not only
to a voltage range, but also to an energy range via calibration.
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The MCA employed (Multiport II) is read out and controlled by the software "Gammamessung
und -analyse". This software allows for the adjustment of several settings, i.a. measurement
times and the number of channels used. To achieve a better energy resolution, it makes sense
to set the number of channels to the highest possible value of 16384.

The software o�ers many more possibilities, like e.g. an automatic energy-channel calibration,
which is, however, not used. The data of the software can be saved as ASCII �les (.TKA), in
which the �rst two lines indicate the speci�ed and actual measurement time. Each following
line corresponds to a channel.

3.6 Coincidence Unit

The job of the coincidence unit is to generate a logic pulse when two or more signals arrive
within a prede�ned time window, the resolution time. The opposite is anticoincidence, where
no pulse is generated if two signals coincide within the resolution time. The coincidence
module used can switch between two time scales. It supports the ranges 10 ns to 100 ns and
0,1µs to 1µs. Please note that the adjustment via the wheel is not linear. Because of this,
you should de�nitely take a look at page 4-3 of the respective Canberra manual (Model 2040
Coincidence Analyzer), which is provided in this lab course's room.

3.7 Counter

A counter is to be connected to the coincidence unit to count the logic pulses. The module
used additionally has a clock, meaning a measurement time can be set. The counter has two
channels which can be counted in parallel. The tallies are shown on a display. Resetting
is done using a button, as are starting and stopping the measurement. Using the clock, a
maximum measurement time can be set as wished in units of 0,01 seconds or 0,01 minutes. It
should be noted that the time is entered in the form NM · 10p. This means that N indicates
the 10's, M the 1's and p the power of 10 of the chosen time unit. Setting N and M to 0
turns o� the clock.
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4 Procedure

Before you insert any sources into the setup, you should perform the following mechanical
adjustments and measurements:

� Using the callipers, measure the distance between the detectors and the source.

� Adjust the aperture of the lead wedges (collimator) in front of the detector, such that
the distance between the inner sides is roughly 0,5 cm on the side near the detector.
Loosen the four set screws slightly from below in order to do this.

� Try to align both collimators as symmetrically around the radiation axis and perpendicularly
to the detector surface as possible.

� Measure the distance from the detectors to their respective collimator.

� Set up an angle of 0° between the detectors.

� A photo from perpendicularly above is helpful during any potential troubleshooting
later on.

4.1 Energy Spectroscopy

Figure 8: Setup for energy spectroscopy. Depending on the setup, either the dashed or the
dotted signal path is used.

� Supply PM1, which is mounted in a �xed position, with a high voltage of 490V (left
Canberra 3102D module, HV supply, cables have already been connected, please do not
remove them). Please note the format of the numbers on the HV power supply: the
smallest number shown corresponds to 10V, i.e. the required 490V correspond to 0,49
on the display.

� The signal cable of PM1 is already connected to the input of an ampli�er. Make sure
that the polarity is set to +. Connect the unipolar output to the �rst input of the
MCA. If signal shaping is adjustable, choose a shaping time of 0,5µs.

� Start the read-out software (desktop icon "Gammamessung und -analyse") on the
PC (user Praktikum, no password). Place the 152Eu sample in front/on top of the
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detector and click on Start inside the program to start the measurement. Choose the
ampli�cation settings, such that the entire spectrum is recorded. For this, you will have
to wait around 30 seconds before all peaks are discernible. Hint: 3 small peaks should
be visible on the left and a fourth peak on the far right! The ampli�cation settings you
chose should be on the order of (≈ 500).

� Record the spectra of 152Eu, 60Co and 22Na for 10 minutes each and save each of the
spectra as a .TKA-�le. This creates an ASCII �le with the measured data. In the
created �le, the �rst line indicates the speci�ed measurement time and the second line
the actual measurement time in seconds. Each of the following lines corresponds to one
of the MCA's channels. Additionally perform a blank measurement in order to be able
to estimate potential background e�ects. Use the same, unaltered ampli�er settings for
all isotopes.

� At home, you should determine the energy resolution and e�ciency of the detector
from these measurements. Think about which other quantities you have to determine
to do this and write these down. Use the data recording time to acquaint yourself
with the di�erent modules using the second detector (same settings as PM1) and the
oscilloscope. For example, take a look at the di�erences between a unipolar and a
bipolar signal, check how the signal changes when the shaping time is changed and look
at the combination of the ampli�ed signal (using a T connector if needed) and the SCA
output. Hint: use the Single Seq. button on the oscilloscope if necessary.
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4.2 Coincidence Measurement

Figure 9: The setup used for the coincidence measurement. Depending on the setup, either
the dashed or the dotted signal path is used.

4.2.1 22Na Annihilation Peak

� Supply PM2 with a high voltage of 490V (right Canberra 3102D module, HV supply,
cables have already been connected, please do not remove them). The signal cable of
PM2 is already connected to the input of the second main ampli�er (right module).
Set the polarity to positive and, if possible, set the shaping time to 0,5µs. Place the
60Co or 152Eu source in front of the detector and, as before, choose a good ampli�er
setting (≈ 500) for PM2's signal branch by using the MCA.

� Now place the 22Na source on top/in front of the detector. If needed, connect the
unipolar outputs of the ampli�ers with the inputs of the respective SCAs mounted to
the right. Next, connect the output of one of the SCAs with the input of the counter.
Adjust a �xed window setting ∆E of 0,2V and scan the entire spectrum. To do this,
vary the lower level E in steps of 0,20V across the range 0−10V and �nd out at which
voltage the annihilation peak can be found for both detectors. Using this data, choose
a value for the lower level E for which, for a window width ∆E of approximately 0,8V,
the entire peak of the spectrum is recorded.

� Now determine the resolution time and the setup's optimal delay. Place the 22Na
sample in between both detectors. First, adjust the resolution time of the coincidence
module to roughly 30 ns. Connect one SCA output with the input of the delay module.
Then connect the output of the �rst delay stage to the second delay stage of the delay
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module. Finally, connect the output of the second delay stage as well as the output
of the second SCA module to the coincidence module. The output of the coincidence
module should be connected to the counter. Both channels used should be switched
to �IN� on the coincidence module. Now scan the delays in steps of 30 ns and record
the corresponding counter readings after a �xed measurement time of e.g. 10 s. Note
that even without any additional delay switched on, each delay stage has an intrinsic
delay of 2,5 ns. After going through all delays for one PM, connect both SCA outputs
directly to the coincidence unit. This measurement corresponds to a delay of 0 ns. After
that, delay the other PM. If you plot the counted events against the delay, the result is
approximately a Gaussian. Adjust the delay to the mean of this distribution. Next, vary
the resolution time in sensible steps (not necessarily equidistant) up to the maximum
possible value of the longer range and, again, for each setting count the events within a
sensible period. Plot the event counts against the true resolution time and determine an
optimal resolution time setting. In case you cannot identify an optimal resolution time
from this graph, choose a resolution time equal to the width of the Gaussian distribution
of the delay �t. For the conversion of the set resolution time to a true time, please see
page 4-3 of the Canberra manual.

� The signal of one SCA should now pass through the delay unit and be connected to an
input of the coincidence module. The signal of the second SCA should be connected
directly to another input of the coincidence unit.

� Count the events from -10° to 10° in steps of 2° with both detectors in coincidence for
a measurement time of 2 minutes each.

The PicoScope can be used to make the preampli�ed analog signal of the PM, the unipolar
output from the ampli�er module and the digital signal of the SCA visible. The following
setup could be established

1. PM output → ampli�er input (back side)

2. PM output (back side recommended) → PicoScope

3. Unipolar ampli�er output (back side recommended) → PicoScope

4. Unipolar ampli�er output → SCA input

5. SCA output (back side recommended) → PicoScope

It is recommended to use one side (e.g. the backside) of the modules for connections with
the PicoScope to keep the wiring well-arranged. Note that a 50 Ω termination resistance
behind the SCA is required. One experimental setup has SCA and ampli�er combined in
one module. The output is shown in Figure 10. In order to �nd ampli�ed signal and the
corresponding output, a simple edge trigger is useful (cf. Sec. D.2.4). Possible values for the
input range etc. of the channels and the trigger can be found in the �gure or alternatively
in Table ?? (Some values di�er from the ones in the �gure especially for the pre-ampli�er as
another PMT is used there). To see both outputs, it is strongly recommended to trigger on
the SCA output. If a trigger is applied on the ampli�ed signal, one often sees no SCA signal
because it has only an output in a small energy window. But in case there is an SCA signal,
a peak form the ampli�er is always expected so it is best to trigger on the SCA output. A
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Figure 10: The preampli�ed PM signal (red, channel B) and the corresponding
ampli�er (yellow, channel D) and SCA output (blue, channel A). A trigger was applied to
�nd the relative short signals. Note that the input ranges of the signals are di�erent and the
signals are vertically shifted by a scale o�set. The upper image corresponds to a shaping time
of 0.5 µs and the lower has 4 µs. Ampli�er and SCA are calibrated to the γ peak of Na22.
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scale o�set (cf. Sec. D.2.3) can be used to shift the signals vertically.

The SCA output should always have an amplitude of about 5 V and a pulse width of about
500 ns. When changing the lower energy level E of the SCA, the SCA amplitude and pulse
width do not change but the amplitude of the ampli�er output increases or decreases when
an SCA signal is observed and if E was increased or decreased, respectively. The energy
window ∆E controls the upper energy level of the SCA. If ∆E is large, the amplitudes of
multiple ampli�er outputs for the corresponding SCA signal vary more in comparison to a
narrow energy window.
The e�ect of di�erent shaping times becomes visible. A short shaping time gives a short
ampli�er peak which becomes visible after the PM output reaches its maximum after a
relatively short period of time. A longer shaping time gives a broader and more delayed
ampli�er peak.

4.2.2 Finding the Annihilation Peak

The measurement feature of the PicoScope can be used to count rising edges automatically.
Heretofore, the counting is performed with a counter module but using the PicoScope has the
advantage of being able to read out the data automatically and store it for further processing.
One SCA output is connected to the PicoScope preferably with a 50 Ω termination resistor.
At the SCA, ∆E = 0.2 V is set and E is set to the lower (or upper) end of the interval which
is of interest. In general, a full sweep of the 10 V range of the SCA has to be performed
but due to the use of the MCA beforehand one often has a rough estimate in which voltage
range the γ-peak is. In this experiment, the Collection Time should be as large as possible
while still being able to perform the measurement. In order to achieve this, the Number
of Samples, (cf. D.2.6) of the PicoScope must be decreased, the resolution should be small
and not used channels should be deactivated. The sample interval must be small enough to
capture the SCA peaks. Possible values for the settings and the measurement are shown in
Table 1. The Input range, O�set and Resolution are not important as digital HIGH signals
are considered. The Collection Time and measurement time should be as large as possible
to obtain good statistics but they are usually limited by the measurement. Reducing one or
the other value might be necessary to perform a successful measurement. A measurement is
shown in Figure 11.

4.2.3 Angular Distribution of 60Co

� Proceed similarly to the 22Na measurement. Set a �xed window setting (window ∆E)
of 0,2V and scan the spectrum. To this end, vary the lower level E in steps of 0,20V
across 0 − 10V and �nd out at which voltages the two peaks can be found. Based on
these result, set the SCAs to one photopeak each with a window width of 0,80V.

� Connect all cables in the same way as for the last step of the measurement of the 22Na
annihilation peak. Keep the previously determined optimal delay and resolution time
values.

� Measure the angular distribution of 60Co from 0° up to the maximum possible angle
(≈ −82°) in steps of 10°. Perform one test measurement for a timespan of 5 minutes
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Table 1: Proposed settings for counting peaks received from the SCA. If the measurement
cannot be performed (i.e. - - are displayed in the measurement section), some settings should
be decreased. Always make sure that the Number of Samples is large enough for capturing
the SCA peaks.

Settings Values
Input range ±5 V
Collection time 10 ms/div
O�set not necessary
Resolution 8 bits
Sample interval 2*<500 ns
(depends on Number of Samples)
2*Number of Samples ≥ 300 kS

(for a Collection Time of 10 µs/div)
Measurement

Mode Rising or Falling Edge Count
2*Span Whole Trace (or between rulers with appropriate

time span if measurement is not successful)
Threshold Automatic

at 0°. Based on the theoretical expectation, the test measurement and the expected
statistical errors, determine a suitable measurement duration for each angle.

� Finally, delay one PM maximally. Measure one more time for the determined measurement
duration and subtract the measured number from the previous results. What is measured
for these settings and why do you subtract the measurements from each other?

Before the SCA signals are fed into the coincidence module, a delay module is interconnected
and adjusted such that a maximum of coinciding signals is found. The problem arises that
the event rates are comparably low (O(1 Hz) or lower) and thus relatively long Collection
Times of the PicoScope are needed to count a su�cient number of signals. The procedure to
measure count rates with the PicoScope is presented in the following.

The instructions for the measurement of the rate of coincidence signals cannot only be applied
in the part of the experiment where an optimal delay has to be found but for all measurements
with the coincidence module.
Two setups of the measurement are deemed to be possible. Either a moderate Collection
Time and many waveforms are captured or a long Collection Time is used an only one
waveform is considered. The �rst measurement can be used if the count rate is not to low.
If so, the sample standard deviation (calculated by the PicoScope software) can be used as
an uncertainty estimate but if the number of counts per sample is O(1) the sample standard
deviation is usually similar or larger than the mean number of counts. The second option is
to use a long Collection Time where the uncertainty estimate is given by the square root of
the counts. This is the same procedure as using a counter module.
In either case, some settings should be applied always in order to enable a successful measurement.
It must be ensured that the Slow Sampling Mode is not activated (cf. Sec. D.2.6). The
Hardware Resolution (8 bits) and the Number of Samples and should be as small as possible.
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Figure 11: Using the PicoScope to determine the SCA count rates. The Properties
window (right) is used to monitor the sample interval. The presented count rate is comparably
high for this experiment.

The latter must be large enough to resolve the coincidence signals (≈ 1 µs) and the Collection
Time should not be larger than necessary.
For the delay measurement, the settings can be as in Table 2. These settings can also
be applied in other coincidence measurements, e.g. in the measurement of the angular
distribution of γγ events.

5 Analysis

5.1 Energy Spectroscopy

1. Plot the spectra of 152Eu, 60Co and 22Na. In each case, identify the position of the
photopeak and, if possible, the Compton edge.

2. Create a calibration line between the photon energy and the channel number. To
this end, determine the position of the photopeaks by �tting a Gaussian with a linear
background.

3. Determine the energy resolution of the scintillator as a function of energy by determining
the full width at half maximum of the photopeaks. Determine the coe�cients a and b
de�ned in equation (1).

4. Determine the e�ciency ε of the detector from the measured rates of the photopeaks.
For this, calculate the activity of the samples used on the day of the experiment.
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Table 2: Proposed settings for counting peaks of the coincidence module for the determination
of the optimal delay. If the measurement cannot be performed (i.e. - - are displayed in the
measurement section), some settings should be decreased. Always make sure that the Number
of Samples is large enough for capturing the coincidence peaks. These settings could also be
used for other counting measurements in the experiment with the coincidence module.

Settings Values
Input range ±10 V
Collection time 5 s/div
O�set -1 V or less
Resolution 8 bits
Sample interval 2*<1 µs
(depends on Number of Samples)
2*Number of Samples ≥ 100 MS

(for a Collection Time of 5 s/div)
Measurement

Mode Rising or Falling Edge Count
2*Span Whole Trace (or between rulers with appropriate

time span if measurement is not successful)
Threshold Automatic

5.2 Coincidence Measurement

5.2.1 22Na Annihilation Peak

1. Plot the counted events against the delay time and against the resolution time. From
these plots, determine the resolution time and the optimal delay of the setup.

2. Plot the count rates of the coincidence measurement against the angle θ and �t a
Gaussian curve to the data. What is the mean of the distribution? How large is the
standard deviation? To what extend does this correspond to the theoretical expectation
(see section 2.4)? From now on, assume the standard deviation of the Gaussian to be
the statistical error of the angular measurement. If necessary, correct the angles by a
systematic deviation.

5.2.2 Angular Distribution of 60Co

1. Plot the correlation function W (θ) for the measured angular range, where:

W (θ) = N coinc
measured (θ) /N

coinc
measured (0

◦) ·Wtheo (0
◦) (14)

2. Now perform a �t of the form

W (θ) = 1 + a2 · cos2 (θ) + a4 · cos4 (θ) + . . . (15)

to the measured angular range. Up to which power of cos (θ) should be included in
the �t and why? Con�rm the theoretical values of the coe�cients ai, as well as the
goodness of your �t (error analysis!).
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A Räumliche Gestalt der γ−Strahlung

Bei der γγ−Winkelkorrelation interessieren wir uns ausschlieÿlich für die γ−Emission, die als
elektromagnetische Strahlung wahrgenommen wird.

Um die räumliche Gestalt der Strahlungsintensität zu verstehen, kann man die Maxwellgleichungen
im Vakuum verwenden:

rotE⃗ = −∂B⃗
∂t

; rotB⃗ =
1

c2
∂E⃗

∂t
; (16)

Es wird dabei berücksichtigt, dass die Felder quellenfrei sind:

divE⃗ = divB⃗ = 0 (17)

Mit der Annahme, dass die E⃗− und B⃗−Felder eine Zeitabhängigkeit der Form e−iωt besitzen
und mit der nichtrelativistischen Dispersionsrelation c = ω

k , bekommt man:

rotE⃗ = ickB⃗; rotB⃗ = − ik
c
E⃗ (18)

Die Gleichungen können nun ineinander eingesetzt werden, um die bekannteWellengleichungen
zu bekommen:

(∆ + k2)E⃗ = 0; (∆ + k2)B⃗ = 0 (19)

Wir suchen zunächst die Lösungen der entsprechenden skalaren Wellengleichung:(
∆+ k2

)
ψ(r⃗) = 0 (20)

Um eine Quelle gehen die Strahlung kugelförmig aus. Es wird deswegen der kugelförmige
Ansatz gewählt:

ψ(r, θ, ϕ) =
U(r)

r
· P (cosθ) ·Q(ϕ) (21)

Durch Aufstellung von Di�erentialgleichungen in Kugelkoordinaten und Verwendung eines
Potenzreihenansatzes (siehe z.B. [2]) bekommt man als Lösungen der θ−Abhängigkeit die
zugeordnete Legendrepolynome:

Pm
l (x) =

(−1)
m

2ll!

(
1− cos2θ

)m/2 dl+m

d(cosθ)l+m

(
cos2θ − 1

)l
, (22)

wobei l = 0, 1, 2, 3, ... und m = 0,±1,±2, ... ± l sind. Die Felder sind also quantisiert. Die
φ−abhängigen Lösungen sind ganz einfach durch

Q(φ) = eimφ (23)

gegeben. Die Radialabhängigkeit wird durch die sphärischen Besselfunktionen beschrieben:

jL(kr) =

√
π

2kr
Jl+ 1

2
(kr), (24)
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wobei Jl+ 1
2
die gewöhnlichen Besselfunktionen sind. Für unsere Zwecke ist diese radiale

Abhängigkeit aber nicht interessant, da wir später nur Winkelverteilungen betrachten werden.
Die φ−und θ−Terme der Lösungen können wir aber als Kugel�ächefunktionen zusammenfassen:

Ylm (θ, φ) =

√
2l + 1

4π

(l −m)!

(l +m)!
· Pm

l (cosθ) · eimφ (25)

Die Anregungszustände des Kerns können als Eigenfunktionen des Kernspins I⃗ beschrieben
werden. Beim Übergang zwischen Anregungszuständen werden γ−Quants mit Energien
emittiert, die den Energiedi�erenzen der Zustände entsprechen. Deshalb ist es auch logisch,
dass das Strahlungsfeld der Kerne auch als Eigenfunktionen des Drehimpulses l⃗ beschreiben
werden kann. Im nächsten Schritt suchen wir die Lösungen der Feldgleichungen (19), indem
wir den Drehimpulsoperator

l⃗ = −i(r⃗ × ∇⃗) (26)

an die skalaren Wellenfunktion ψ(r⃗) anwenden. Wir bekommen mit Hilfe der vektoriellen
Kugel�ächenfunktion X⃗m

l (θ, φ) = 1√
l(l+1)

l⃗ · Y m
l (θ, φ) folgende Abhängigkeiten:

E⃗m
l ∝ X⃗m

l ; und B⃗m
l ∝ − i

kc
rot

(
E⃗m

l

)
(27)

B⃗m
l ∝ X⃗m

l ; und E⃗m
l ∝ ic

k
rot

(
B⃗m

l

)
(28)

Durch Summieren dieser Lösungen für alle möglichenm und l bekommt man eine vollständige
Multipolentwicklung des elektromagnetischen Strahlungsfeldes. Wir bezeichnen nun der Kernspin
des Anfangs- bzw. Endzustands durch I⃗1 bzw. I⃗2 . Wegen der Drehimpulserhaltung bekommt
man folgenden Auswahlregeln für die Quantenzahlen:

|I1 − I2| ≤ l ≤ I1 + I2; mit m = m1 −m2 und |m| ≤ l, (29)

wobei meistens die niedrigste Multipolordnung dominiert. Für eine Erklärung dazu wird auf
[3] hingewiesen.

In der Kernspektroskopie ist es wichtig zwischen elektrischer E und magnetischerM Multipolstrahlung
zu unterscheiden. Leider ist es nur durch die Messung der Polarisation der γ−Strahlung
möglich, den Strahlungscharakter, also ob es sich um eine El- oder Ml-Strahlung handelt,
zu bestimmen. Es lässt sich aber theoretisch zeigen, dass die Übergangswahrscheinlichkeit
für elektrische Multipolstrahlung viel höher als die für magnetische Multipolstrahlung bei
derselben Ordnung ist.

Photonen werden in der Form eines 2l−Pol Multipolfelds der Multipolordnung l emittiert.
Man merke, dass ℏl dem vom Photon angenommenen Gesamtdrehimpuls entspricht, mit einer
Projektion auf der z-Achse von mℏ. Da das Photon einen intrinsischen Spin von 1 besitzt,
ist der Wert l = 0 nicht möglich. Abbildung 12 zeigt ein Beispiel von erlaubten und nicht
erlaubten Übergängen anhand einer 0 → 1 → 0 Kaskade.
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Figure 12: Beispiel erlaubter Übergänge für 0 → 1 → 0 Kaskade

Das Bild zeigt, dass für∆I = 1 die Übergänge mitm = 0 nicht erlaubt sind. Die physikalische
Begründung dafür wird im folgenden Abschnitt diskutiert.

Letztendlich interessieren wir uns für die gemessene Intensität, die durch den Betrag des
Poynting Vektors gegeben ist:

I = |S⃗| = ε0cE
2 ∝ |Xm

l |2 (30)

Durch Anwendung Vernichtungs- und Erzeugungsoperatoren berechnet man für den Betrag
der vektoriellen Kugel�ächenfunktion [4]:

|Xm
l (θ)|2 = 1

2l(l+1) [(l (l + 1)−m (m+ 1)) · |Y m+1
l (cosθ) |2

+(l (l + 1)−m (m− 1)) · |Y m−1
l (cosθ) |2] (31)

Durch Einsetzen von l = 1 und m = 0,±1 bekommt man dann folgende Lösungen:

|X0
1 |2 =

3

8π
· sin2θ; und |X±1

1 |2 =
3

16π
·
(
1 + cos2θ

)
(32)

In Abbildung 13 werden die beide Lösungen als Polardiagramme dargestellt.
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Figure 13: Gestalt der vektoriellen Kugel�ächenfunktionen. Links: |X0
1 (θ) |2 Rechts:

|X±1
1 (θ) |2

Anhand dieser Bilder ist deutlich zu sehen, dass die Winkelverteilungen und deswegen auch
die Intensitäten spiegelsymmetrisch zur 90◦−Achse sind. Eine genauere Betrachtung der
Gestalt der Kugel�ächenfunktion, bzw. des zugeordneten Legendrepolynomes zeigt, dass
beim Quadrieren nur gerade Potenzen von cos (θ) vorkommen. Es ist auch leicht zu sehen,
dass die φ−abhängige Komponente Q(φ) = eimφ beim Bilden des Betragsquadrats weg fällt.
Deswegen ist die Winkelverteilung auch nur von θ abhängig.

Für unsere in Abb. (12) gezeigten Beispiel mit ∆I = 1 sind |X0
1 (θ) |2 und |X±1

1 (θ) |2 die
beiden möglichen Winkelverteilungen. Wie man in Abb. (13) sieht, emittiert nur |X±1

1 (θ) |2
Quanten in z−Richtung. Die Winkelverteilung lässt sich aber nur gegen eine festgelegte
z−Achse bestimmen. Es können also mit Hinsicht auf diese Quantisierungsrichtung nur die
Zustände mit den magnetischen Quantenzahlen m = ±1 besetzt werden.

B Die Parität

Die ParitätΠ ist eine multiplikative Quantenzahl, die den Symmetriecharakter der Wellenfunktion
bei Raumspiegelung beschreibt. Durch Spiegelung der Koordinatensystems an der Ursprung:

r⃗ → −r⃗ (33)

sollen sich bei Erhaltung der Parität die Eigenschaften des Systems nicht ändern. Die
Wellenfunktion darf sich nur um den konstantenWertΠ ändern, wobei eine Rücktransformation
wieder die ursprüngliche Funktion liefert, also Π2 = 1. Ein System hat die Parität +1 wenn
gilt [5]:

ψ (−r⃗) = ψ (r⃗) (34)

und hat die Parität −1 für:
ψ (−r⃗) = −ψ (r⃗) . (35)
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Die Parität ist in der elektromagnetischen Wechselwirkung eine Erhaltungsgröÿe des Systems.
Durch Anwenden des Paritätsoperators auf die Multipolfelder, bekommt man für die elektrische
Multipolstrahlung eine Parität von Π = (−1)

l und für die magnetische Multipolstrahlung
eine Parität von Π = (−1)

l+1. Beim Übergang zwischen Kernzuständen 1 und 2 gilt also die
Beziehung:

Π1 = (−1)
l ·Π2 (36)

für elektrische Strahlung und
Π1 = (−1)

l+1 ·Π2 (37)

für magnetische Strahlung.

Anhand die beide Gleichungen ist es also grundsätzlich möglich zu bestimmen, ob beim
Strahlungsübergang eine Paritätsänderung stattgefunden hat. In Tabelle (3) sind mehrere
Beispiele von γ−Übergängen für unterschiedliche Multipolordnungen und Kernspinänderungen
gegeben. Die in Klammern gesetzte M-Strahlungen sind wegen der niedrigen Übergangswahrscheinlichkeit
praktisch nicht zu sehen.

Kernspinänderung |∆I| 0 1 2 3 4

Paritätsänderung E1; (M2) E1; (M2) M2; E3 E3; (M4) M4; E5
keine Paritätsänderung M1; E2 M1; E2 E2; (M3) M3; E4 E4; (M5)

Table 3: Multipolordnung El und Ml in Abhängigkeit von der Kernspin- und
Paritätsänderung. Entnommen aus [3].

Hinweis: Der Bezeichnung I+ bzw. I− bedeutet Kernspin I mit Parität Π = ±1.

C Koinzidenzmessung

Wie schon erwähnt wurde, ist die Intensität der emittierten Strahlung durch I ∝ |X⃗m
l (θ) |2

gegeben. Falls die magnetischen Unterniveaus m gleichwahrscheinlich besetzt sind, ist die
emittierte Strahlung aber letztendlich eine Überlagerung aller verschiedenen Unterniveaus.
Zum Beispiel gibt es für l = 1 drei mögliche Unterniveaus: m = 0, +1, −1. Damit erhalten
wir als Überlagerung:

I ∝ |X⃗0
1 (θ) |2 + |X⃗+1

1 (θ) |2 + |X⃗−1
1 (θ) |2 =

3

8π
sin2θ +

3

8π

(
1 + cos2θ

)
=

3

4π
(38)

Die Intensität ist also isotrop über den ganzen Winkel θ. Erst bei einer Ungleichbesetzung der
magnetischen Unterzustände, also eine anisotrope Verteilung, ist es möglich, eine Winkelverteilung
zu messen.

Die Koinzidenzmessung bietet eine Lösung zu diesem Problem. Es kann letztendlich nur
mit Bezug auf eine feste Quantisierungsachse die Winkelverteilung gemessen werden. Durch
Emission des ersten γ−Quants wird eine solche Achse festgelegt. Die Unterzustände des
Zwischensystems hinsichtlich dieser Richtung sind dann verschieden besetzt: Man bekommt
also eine Winkelverteilung für das zweite Quant W (θ). Wie in die Einführung schon erwähnt
wurde, interessieren wir uns bei der γγ−Winkelkorrelation für Zwischenzustände mit extrem
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Figure 14: Quantenzahlen für γγ−Kaskade mit reinen Multipolaritäten

kurzen Lebensdauer, so dass beide emittierten Photonen �praktisch zeitgleich� ankommen
(Lebensdauer des Zwischenzustands bis zu ∼ ms). Ein solches Ereignis wird Koinzidenz

genannt.

Im Allgemein lässt sich die Winkelverteilung oder �Winkelkorrelation� W (θ) in der Form [6]:

W (θ) = 1 +A2 · P2 (cosθ) +A4 · P4 (cosθ) + ...+A2kmax
· P2kmax

(cosθ) (39)

schreiben, mit
kmax =Min (I, L1, L2) (40)

Hier werden die Drehimpuls Quantenzahlen des ersten und zweiten γ−Quants mit L1 und L2

bezeichnet. Die Anfangs-, Zwischen- und Endzustände haben die Kernspin Quantenzahlen:
Ii, I und If (siehe Abb. 14). Pν (cosθ) bezeichnen die Legendre Polynome.

Wie oben schon erwähnt wurde, betrachtet man in der Praxis meistens nur Übergänge
mit reinen Multipolaritäten. Unter dieser Voraussetzung kann man eine Vereinfachung der
Theorie, anders gesagt, eine �Naive Theorie� verwenden. Wir betrachten nun wieder die
Übergangswahrscheinlichkeit eines 2-Niveau-Systems und erhalten:

W (Ii, mi → If , mf ) = konst. ·G (mi, mf ) (41)

Hier ist der konstante Term durch das Kernmatrixelement gegeben. Der geometrische Term
G ist gleich dem Quadrat des Clebsch-Gordan-Koe�zienten:

G (mi, mf ) = ⟨If lmfM |Iimi⟩2, (42)

wobei die Multipolarität der Strahlung wieder mit l und mit Projektor M = mf − mi

bezeichnet wird. Für die Winkelverteilung der emittierten Gamma-Strahlung einer orientierten
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Quelle erhält man [7]:

Xl (θ) =
∑

mi,mf

P (mi) · ⟨If lmfM |Iimi⟩2 · |X⃗l
mi−mf

(θ) |, (43)

wobei |X⃗l
mi−mf

(θ) | wieder die vektoriellen Kugel�ächefunktionen sind. Wie schon erwähnt
wurde, führt die Emission eine Isotrope Quelle in eine festgelegte Richtung (z−Achse) zu einer
Orientierung im Endzustand, was eine anisotrope Winkelverteilung der zweiten Strahlung zur
Folge hat.

Wir betrachten deswegen wieder das Drei-Niveau-System, welches in Abb. 14 zu sehen ist.
Wegen der Annahme reiner Multipolaritäten gilt m2 = m−mf und m1 = m−mi. Für die
Besetzungswahrscheinlichkeit im mittleren Zustand I, m bekommen wir:

P (m) =
∑
mi

⟨IL1mm1|Iimi⟩2 · |X⃗mi−m
L1

(θ = 0) | (44)

Dies setzen wir in die Gleichung (43) für den zweiten Strahlungsübergang ein und erhalten
für die Winkelkorrelationsfunktion:

W (θ) =
∑

mf,m,mi

⟨IL1mm1|Iimi⟩2 · |X⃗mi−m
L1

(θ = 0) | · ⟨IfL2mfm2|Im⟩2 · |X⃗m−mf

L1
(θ) | (45)

Die Winkelverteilung lässt sich aber noch weiter simpli�zieren. In der Fachliteratur wird die
Korrelationsfunktion oft als Summe gerade Potenzen von cosθ dargestellt [2]:

W (θ) = 1 + a2 · cos2θ + a4 · cos4θ + ...+ a2kmax · cos2kmaxθ, (46)

wobei die Reihe wieder bei kmax = min (I, L1, L2) abbricht. Es wurde auch das erste Glied
auf 1 normiert, so dass man sich in der Praxis meistens nur für die Koe�zienten a2 und
a4 interessiert. Sie können experimentell aus einer gemessenen Winkelverteilung bestimmt
werden. Es werden in Tabelle 4 die theoretischen Zahlenwerte für a2 und a4 für einige
γ−Kaskaden angegeben.

Kaskade Ii (L1) I (L2) If a2 a4

0 (1) 1 (1) 0 +1 0
1 (1) 1 (1) 0 − 1

3 0
1 (2) 1 (1) 0 − 1

3 0
2 (1) 1 (1) 0 − 1

3 0
3 (2) 1 (1) 0 − 3

29 0
0 (2) 2 (2) 0 −3 +4
1 (1) 2 (2) 0 − 1

3 0
2 (1) 2 (2) 0 + 3

7 0
2 (2) 2 (2) 0 − 15

13 + 16
13

3 (1) 2 (2) 0 − 3
29 0

4 (2) 2 (2) 0 + 1
8 + 1

24

Table 4: Die Koe�zienten a2 und a4 für einige γ−Kaskaden, entnommen aus [2].
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Anhand dieser Tabelle werden die Begrenzungen der γγ−Winkelkorrelation als Messmethode
direkt klar. Die gemesseneWinkelverteilung liefert keine eindeutige Zuordnung der Koe�zienten
zu einer bestimmten Kaskade. Auÿerdem liefert diese Methode keine eindeutigen Informationen
über die Parität des Zustands, da die obigen Ergebnisse sowohl für elektrische als auch
magnetische Strahlung gelten. Information über die Parität kann nur über ein schon zum
Teil bekanntes Bild des Zerfallsschemas gewonnen werden.

D Introduction of the PicoScope

D.1 Setup of the PicoScope

D.1.1 Hardware

Usually, the PicoScope oscilloscope can be used in the experiments without major changes to
the existing experimental setup.
The power supply of the PicoScope oscilloscope is plugged in and the oscilloscope is connected
to a PC via an USB cable. Four independent channels can be connected via the BNC
connectors on the front. For instance, probes which are delivered with the PicoScope can
simply be connected to such an input.
The used PicoScope model also features an output channel which can be adjusted with the
software such that it outputs the de�ned function.
The described input and output connections are displayed in Figure 15.

Figure 15: An overview over the inputs and outputs of a four channel
PicoScope. https://www.picotech.com/download/datasheets/picoscope-5000d-series-
data-sheet.pdfSource.

D.1.2 Software

On the homepage of pico Technology, the software PicoScope can be obtained which has to
be installed to access and control the PicoScope oscilloscope. After starting the software, the
PicoScope oscilloscope should connect automatically.
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D.2 Using the software

The basics for operating the PicoScope software are explained in this section. Also some
advanced features will be described as they proved useful in the actual experiments of the lab
course.

D.2.1 General remarks

Depending on the context, it can be advantageous to save certain settings of the PicoScope in
order to load them at a later time. This can be achieved at File → Start-up Settings → Save
Settings As... and a setting �le is accessed by either opening it in the Windows Explorer
(if automatically associated with the PicoScope software) or use File → Open. In the menu
Start-up Settings it is also possible to set default settings which are always loaded when
starting the software or set the option to restore the settings of the last PicoScope session.
The latter option is especially useful if one wants to continue with some work in the software
after it was closed. Therefore, it is advised to activate this option as default settings if no
user default settings are set.

D.2.2 Scope Mode and Persistence Mode

Two di�erent view modes are used in the lab course. The Scope Mode shows the signal
captured during the Collection Time once. The Persistence Mode overlays multiple recorded
signals and fades out the signals with time. This behaviour can be associated with the
afterglow of signals on an analog oscilloscope.
Both modes share many settings regarding the display of the signal (e.g. Input Range
and O�set) which are explained in Section D.2.3. However, the Persistence Mode features
additional settings to modify the afterglow e�ect. Most important are theMode setting (cf. Fig. 16)
where Digital Color uses di�erent colors to indicate how often a certain signal value occurs
at a given time and Analog Intensity draws recent signals with full intensity while signals get
paler with time. The options Decay Time, Saturation and Decayed Intensity de�ne the time
how long a signal takes to fade out, the intensity with which a new signal is drawn and the
intensity at which signals remain after the decay time elapsed, respectively.
A special characteristic of the Scope Mode is the possibility to save waveforms not only as an
image but also the data points in a csv or txt �le. This is emphasized in Section D.2.5 and
not possible in the Persistence Mode. It is also possible to view some previously captured
signals which are stored in the bu�er. Another view mode is the Spectrum Mode which uses
a fast Fourier Transformation to display a spectrum view. As this mode is not used in the
lab course currently, this feature is not covered here in further detail but information can be
found in the PicoScope user's guide. Both view modes are shown in Figure 16.
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Figure 16: Displaying the signal in the Scope Mode (top) and Persistence Mode (bottom).
The blue arrows indicate where the view modes can be accessed. The orange arrow shows the
menu for the bu�ered waveforms and the green arrow marks the options for the Persistence
Mode. A trigger has been in both view modes.
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D.2.3 Changing the display of the input signal

The di�erent options to modify the display of the signal are explained using Figure 17. The
green boxes show the options which apply to all channels.

Figure 17: Options to modify the display of signals. THe Scope Mode is used. Further
information can be found in the text.

[noitemsep]The Collection Time determines how long a capture of a signal lasts. Usually,
the time is stated per division . The total time is derived by using a factor 10 for the
number of divisions. The Number of Samples does only need attention in some cases.
The number stated is an approximate value. In the menu Views → View Properties,
the actual number of samples as well as the sampling interval can be seen. For many
purposes the default set value of Number of Samples is su�cient but for short-lived peaks
and large Collection Times the sample interval should be considered eventually. The
Hardware Resolution can take values from 8 to 16 bits and determines the quality of the
digitized signal. Note that 15 bits and 16 bits resolution are only possible if two and one
channel, respectively, are used. Using the option Auto resolution is usually su�cient.
The zoom functions can be used to enlarge a region of the scope and investigate the
waveform closer without changing the Input Range or Collection Time.

The following options can be adjusted for each channel individually.

[noitemsep]The Input Range option determines the minimal and maximal input value
for the channel. A channel can also be turned o�. If the recorded signal is larger than
the Input Range, a warning (Channel overrange) is displayed in the upper left corner
and the input range should be increased. The Coupling can be set to AC or DC. In
the AC mode, frequencies ≲ 1 Hz are �ltered out. Therefore, DC o�sets are not visible,
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allowing for more precise signal measurements but relative voltages with respect to the
ground cannot be measured. In the DC mode, the signal is measured with respect to
the ground. An Analog O�set can be applied to the input before digitization. This is
useful cases where the maximum amplitude is known, e.g. if pulses with height 10 V
are expected, the Input Range of ±10 V does not have to be used but ±5 V with an
Analog O�set of −5 V. The Axis Scaling options can be used to manipulate the display
of the signal. In contrast to the Analog O�set, these options apply to the axis not the
signal.

D.2.4 Trigger

A plethora of triggers is available which are especially useful for �nding rare and short-lived
signals. The options are explained with Figure 18. All options regarding trigger are set in
the menu bar at the bottom of the software.

Figure 18: Trigger menu (green) at the bottom of the PicoScope menu. The context menu of
the Advanced Triggers (blue) is shown. Further information can be found in the text.

[noitemsep]Di�erent Trigger Modes are available determining what signals are
displayed. The most important are

(1)(2)(3)(4)(5)(6)(7)(8)(1) � None: No trigger is used.

� Auto: Displays a triggered waveform but if no present the input signal is displayed
regardless of the trigger.

� Repeat : Displays only triggered waveforms.

(2) Advanced Triggers can be used but usually the Simple Edge trigger is su�cient which
�res when the signal passes through a certain threshold. The other triggers have
additional features, e.g. allowed voltage windows for the signal. The options (3)-(5)
can also be adjusted in this context menu.
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(3) Usually, the Trigger Channel is the same as the displayed signal. If multiple inputs are
displayed, one channel has to be chosen which triggers for all inputs. It is also possible
to trigger on an external channel.

(4) The Edge Select option allows to trigger on either falling or rising edges.

(5) The Threshold can be typed in at the menu bar, in the Advanced Triggers menu or by
dragging the marker (yellow square in the scope) at the desired position.

(6) The Pre-trigger determines how much of the signal is captured and displayed before
the trigger �res. It can also be adjusted by dragging the marker in the scope.

(7) The Trigger-delay has to be enabled by clicking on the respective item in the menu bar
and determines how much time has to elapse before the trigger can �re again.

For most purposes, the Simple Edge trigger with a su�cient Threshold and Pre-trigger and
correct Edge Select is su�cient.

D.2.5 Saving waveforms

The PicoScope software features the saving of captured waveforms either as an image or a
csv/txt �le if the Scope Mode is used. The latter �le types store single data points and are
useful to analyze the waveforms with another software.
Saving a waveform can be accessed via File → Save or Save As. The appearing window allows
to select a �le location and �lename for the �le. Di�erent �le formats such as �les readable by
the PicoScope software (e.g. pssettings and psdata), text �les (e.g. txt and csv) and images
(e.g. png and jpg) can be chosen. The options in the window allow to save only the currently
displayed waveform, all waveforms in the bu�er or a subset of the bu�ered waveforms. If not
using a PicoScope �le type, a separate folder will be created if multiple waveforms are saved.

The PicoScope also allows to save the waveform automatically every time the trigger �res. For
saving waveforms when the trigger �res, an alarm has to be set up in the menu Tools →Alarms.
In the Alarms dialog window, the event has to be set to Capture and the �rst item (usually
it has the name Beep) of the list has to be selected and edited. The action is changed to Save
Current Bu�er and a directory in which the �les are saved has to be chosen. It is important
to set the �le type explicit to a csv-�le if one wants access the data points and not only obtain
an image of the waveform. The stated �lename will be used for all �les and numbered serially.
E.g. the �lename is set to be waveform. Then the �rst �le is waveform.csv, the second is
waveform (2).csv, the third is waveform (3).csv etc. The set up of the alarm is �nalized
by closing all dialogs with the Save (German: Speichern) or OK button. When starting
the capturing of signals in the PicoScope software (green triangle in lower left corner), every
time the trigger �res, the currently displayed waveform is stored as csv-�le. To turn o� the
saving of pulses, it is easiest to stop the signal capture (red square in the lower left corner)
and turn of the alarm in the alarm dialog window. The whole process is described in Figure 19.

38



D.2.6 Measurements

The PicoScope allows to infer several values of the captured signals. These measurements can
be used to count falling or rising edges which is useful in many experiments of the lab course
whenever peaks are counted. Therefore, this introduction focuses on this measurement but
counting peaks is not the only measurement featured by the PicoScope software.
A measurement is set up (c.f. Fig. 20) via Measurements → Add Measurement (1a) or by
clicking on the + on the lower menu bar (1b). In the appearing context window, multiple
settings have to be set. The input channel is assigned (2). Multiple measurements of di�erent
quantities for di�erent channels are possible. The type of measurements is de�ned (3) which is
Falling Edge Count or Rising Edge Count if the number of peaks is supposed to be measured.
It is possible to use the whole trace for a measurement or only a latter de�ned interval ∆t (4).
The measurement options allow either a threshold to be de�ned or an automatic threshold
to be used (5). The hysteresis can be leaved unchanged. This parameter is linked to a
mechanism that prevents wrongly counts due to �uctuations of the signal near the threshold.
More information on that are provided in the PicoScope user's manual. If the options to use
the whole trace and an automatic threshold, the measurement is ready to start. Otherwise, the
rulers on the horizontal and vertical axis have to be adjusted to determine the measurement
range and the threshold, respectively (c.f. Fig. 21). The values can either by typed in the
ruler legend or de�ned by dragging the rulers to the desired position. The measurement is
found at the bottom with multiple values shown.

[noitemsep]The used Channel and Measurement mode are shown. The Value refers to
the counted edges in the currently displayed waveform. The values Min and Max show
the minimum and maximum counted edges, respectively, in a waveform. The Average
is de�ned by the arithmetic average of the counts in the waveforms. The standard
deviation σ is de�ned by σ2 = 1

N−1

∑N
i=1 (yi − ȳ)

2 where N is the number of captured
samples, yi the number of edges in the i-th sample and ȳ the mean of counted edges over
all samples. The Capture Count determines how many captured samples are considered.
More samples result in better statistics but need more time to be collected. In case the
number of captured samples exceeds the Capture Count, every new samples replaces the
oldest considered sample. Consequently, the other values such as Min and Max only
refer to the currently considered samples and not to all samples ever captured. The
Capture Count can be changed at Tools → Preferences → General → Measurement
Statistics. The Span shows if a ruler-de�ned ∆t is used or the whole trace.

In Section ?? a description is provided on how to access the measured values automatically.
Note that a measurement can fail which is displayed by - - in the overview of the measurement
results. This problem can usually be solved by either decreasing the Collection Time or by
reducing the Number of Samples. Which solution is better depends on the context of the
measurement but if using the latter solution one should check that the sampling interval is
still large enough to capture the signals.
Note: When using large Collection Times (≥ 100 ms/div), the PicoScope has to be hindered
to go into the Slow Sampling Mode otherwise wrong measurement results are obtained. This is
achieved at Tools → Preferences → Sampling → Slow Sampling Transition. Here, a Collection
Time larger than the one used in the measurement has to be chosen.
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D.2.7 Math Channel

The PicoScope software features Math Channels which allow to manipulate one or multiple
inputs with mathematical expressions. The output is displayed as an additional waveform in
the scope and can also be used as an input channel for measurements.
Math Channels are accessed via Tools → Math Channels. The featured built-in operations
are inverting the signal, adding, subtracting, multiplying and dividing two signals. It is also
possible to de�ne functions by clicking on Create in the Math Channel menu and entering
the desired expression.
An application of Math Channels is the implementation of a coincidence counter. Two input
channels which are assumed to be 0 V by default, i.e. in the digital LOW state, and have a
non-zero voltage if they are in the digital HIGH state are multiplied. Only if both channel
are in the digital HIGH state, the function has a non-zero output which is an implemented
logical OR gate. In order to count the number of coinciding events, a measurement counting
the rising or falling edges of the function can be used.
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Figure 19: Saving pulses on trigger. In the Alarm dialog window (1), Capture has to selected
as event by checking the tick box (2). A new dialog window is opened (lower image) by editing
the item in the list (3). The action is set to Save Current Bu�er (4) and the directory, �lename
and �le type are speci�ed (5, 6) in the next dialog window. The �le type should be set to
csv if the data is analysed with another software afterwards. At last, all windows are closed
(blue boxes).
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Figure 20: The measurement window (green frame) is opened via the menus indicated by the
blue arrows. Further information can be found in the text.

Figure 21: Finalizing the measurement by adjusting the ruler (green arrows) or using the
ruler legend (blue arrow). The measurement results are displayed at the bottom (orange
arrow). Further information can be found in the text.
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